PC/Capture V2

PC/Capture is designed to allow a customer to have a real time feed of the events that are happening at
an ECR. Note that since PC/Capture emulates a printer, the functionality of PC/Capture on a particular
register is limited to that register’s support for external printers.

We support the following registers for use with a direct connection or for use with modems:

CRS: 3000

Samd4s: 5x0, 2000, 7000, 1000, 52xx, 65X, 28x, and 390.

Casio: 6600, 6100, 6000, 8500, and 7000

Sharp: 3500, 330x, 8x0, 770, and 750. (We also support the 600/700, but due to a register limitation, we
can only receive report data from them.)

In addition, we support native TCP/IP communication for the following registers:

Samd4s: 5x0 and 2000

Casio: 6600, 6100, and 6000

In addition, we support output from our own AIMsi point of sale software with a direct connection.

General

PC/Capture minimizes to the taskbar when closed. To terminate the application, you must right click on
the task bar icon and select terminate.

Setup

1. Open PC/Capture V2 from the icon placed on the desktop during installation.

Machines Tab
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2. The screen above opens. On the Machines tab, click the plus sign _* button to add a new
record.
3. When the user clicks in the Machine ID field the software will auto fill with the CRS 3000.
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Machines | General | view Logs |

[ auto Start this Machine

Machine 1D |5x0 | Logpath |CiPC Capture v2 Logs
Mg [samas v| LogTyne [Richtext Fie { *.rtf) |
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4. Fillin the appropriate information. Note: When finished be sure to click the check mark ¥
button to add the record.
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Machines | General | view Logs |

[ auto Start this Machine
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5. To add more machines to the bottom grid, click the plus sign . again.
6. When all machines have been added, click the Begin Collection button.
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Casio 6500
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7. The screen above opens as the program starts to collect data from the register.

{7 pC/Capture V2

5x0 | Casio 6600

Collecting @ [ Pause ] [SEndtDEma\I ][ Send to FTP

8. To collect data from multiple machines, highlight the first machine and click the Begin Collection
button, highlight the second machine then click the Begin Collection button and so on until all

machines are added. The software will begin collecting the data for the registers, which in this
case was the Sam4s 5x0 and the Casio 6600.

@ Error opening the port! Please check your connection.

9. If the connection to the machine or machines is not setup correctly, the user may get the error

above. Check the connection and try again.



The setup screen on the Machines tab offers the following options:

Auto Start this Machine  This option allows the user to setup one or more machines to automatically
start collecting data when the software is opened.

Machine ID This is the identifier for the machine that is currently selected. It must be unique.
MFG This is the ECR manufacturer of the current machine.

Model The model of the current machine.

Comm Type This determines the form of communication between the ECR and the PC. All

registers support Direct and Dial Up communication. A few registers also support TCP/IP. Additional
Comm options are listed below.

Direct Connect Options

Direct
[l hTellDirect to COM 10| A

Baud |9600 w

Com Port This is the Comm port to use for communications. Only valid comm. ports will
appear in this list.

Baud Rate This drop down menu allows the user to set the Baud rate. It must match the
setting of the register.

Dial Up

Modem |Standard 9600 bps Modem |

Phone #

Dial Up Options

Modem This is the modem to use for communications. Only valid modems will
appear in this list. Note: The baud rate must be 9600 on both the modem and the register.

Phone # This is the remote phone # for the ECR.

TCP/IP Options

TCP/IP
Address [192.168.0.11

Printer Type |5AM SRP-270 3

Address This is the remote address for the register.



Printer Type This is the printer type to be emulated. It must match the setting at the
register.

Log Options

LogPath |C:\Documents and Settings\barb ray\Ds

Log Type |RichtextFile { *.rtf) £

Default Font Courier New - 123
Log Path This controls which directory the PC/Capture’s log files for this machine are
stored in.
Log Type You can choose to store log files as plain text (No formatting) or Rich Text.
Other Options

Use Styles (Bold, Italic, etc)
Use Colars
Add DateTime Stamps to Data

Default Font This controls the font that PC/Capture writes the log file with. Note that this
option is only effective if the log type is set to Rich Text File.

Use Styles This controls whether or not PC/Capture will save Stylistic data sent from the
register or discard it. Examples would be whether certain letters are bolded or underlined. Note that this
option is only effective if the log type is set to Rich Text File.

Use Colors This controls whether or not PC/Capture will save color data sent from the
register or discard it. Examples would be whether certain letters are black or red. Note that this option is
only effective if the log type is set to Rich Text File.

Add Date/Time Stamp to Data This adds a date/time stamp to each Divider. Note that dividers are
printed when the register sends a “Cut” command. If the register is not set to send “Cut” commands, then
no dividers and thus no Date/Time stamps will be printed.



General Tab

(F: pC/Capture V2
File Help

Machines | General | view Logs

Save Timer |3 @ {(Minutes)
size Limit | 10000 (%¢] ()
[l start Mew File After Every Auto Save

[¥] Always Start New File at: | B:00:00 aM (%

[ auto Emai File On Close Setup Email
[J auta FTP File On Close Setup FTP

10. Click on the General tab for more setup options.
11. Enter the appropriate Save Timer value in minutes as well as the (File) Size Limit. Type a value

in theses entry boxes or use the up and down arrows to increase or decrease the values.

Save Timer This controls how often PC/Capture saves its log files to disk. Log files will
always be saved when the program is closed.

Size Limit When the program saves its log file, it will check to see if it is above the size
limit. If it is, a new log file will be started.

Start New File After Every Auto Save This option allows the user to save data to a new file
after each auto save.

Always Start New File At: When the programs saves it’s log file, it will check whether the set time
has been passed. If it has, a new log file will be started.

Auto Email on Close When a new log file is created, this will email the old one to a set address.

Auto FTP File on Close  When a new log file is created, this will send the old one to an FTP site.



View Logs Tab

File Edit Help

Machines || General | Yiew Logs | Find Al
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This area allows the user to open and view previously saved log files. The user can search these log files
if they wish.

The Find All option under the Edit menu allows the user to display all instances of a particular search
phrase. It is shown below.

Find All Tab
File Edit Help
Machines | General | View Logs | Find Al
Line 000%: MDSE ST 52.95 ~
Line 0465: MDSE ST $1.00
Line 0480: MDSE ST $1.00
Line 0503: MDSE ST $1.00
Line 0515: MDSE ST $1.00
Line 0525: MDSE ST $1.00
Line 0725: MDSE ST $11.80
Line 075%: MDSE ST $2.95
Line 0766: MDSE ST $5.90
Line 0772: MDSE 5T S2.495
Line 0779: MDSE 5T S52.495
Line 0787: MDSE 5T 558.85
Line 0794: MDSE 5T S52.495
Line 0816: MDSE 5T S52.495
Line 0822: MDSE 5T S52.495
Line 0825: MDSE 5T S52.495
Line 0834: MDSE 5T S52.495
Line 0840: MDSE 5T S52.495
Line 0846: MDSE 5T S52.495
Line 0852: MDSE 5T S52.495
Line 0867: MDSE 5T S52.495 3

Double clicking on a line will take the user back to the original log, at the position of the clicked line.



File Menu

& pC/Capture V2
3N Help

Close al | View Logs |
Terminate

Save Timer {Minutes)
Size Limit (KB)
[CIstart Mew File After Every Auto Save
[¥] Always Start Mew File At:
[] auto Email File On Close
[ uto FTP File On Close

The drop down menu at the top of the screen has two options on the Machines and General tab:

Close This menu item closes the software.

Warning

" This will dose PC/Capture and disconnect all currently active machines.

Y Are you sure you want to proceed?

Yes ]

Terminate Clicking the Terminate menu item will open the warning screen above. This
will close PC/Capture and disconnect all currently active machines.

(F: pC/Capture V2

Open log Ctrl+0 ¥ Logs

Close
Terminate




On the View Log tab, the File menu item has two addition items.

Open X
Look\_n:|&)Logs v| Q2 E-
Y lE__]Casm 5600 10_1_2010 10_47_08 AM.rtf
u‘é ) Casin 6600 10_1_2010 11_21_05 AM.rtf
My Recent
Documents
?L.
Diesktop
=g
My Documernts
Iy Clnmputer
Q File name: | hd | [ Open I
My Network | Flescftyps: [Rich Tex Log v [cac |
Open Log This option will open a Open screen allowing the user to browse for and pick

a machine log.

Print The Print option allows the user to print a copy of the selected log file.



Help Menu

(F: pC/Capture V2
File Nz}

Mad  About Logs
Release Code
Help
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The Help Menu has the following three items:

X

About
PC/Caphure 2
Verzion: 2.1.1.1
Copyright 1384-20010 Tri Technical Svstems [nc
Tn Technical Spstems Yoice:  BE3-55E-355E

162 Cedar Crest Ridge Fax: 5E3-556-0405
Dubuque, |4 52003 Sales  zales@technologydretailers. com

wany. bechnolooydretailers. com

About The About screen displays the name of the program, the version of the
installed software, and contact information for Tri-Technical Systems. To close the screen click OK.



QuickBooks Interface V3 Release Code El

To obtain a release code vou must contact your dealer or PC/POLL SYSTEMS. You may call 563-556-2323 or EMaAIL
SaLESEtechnologydretailers. COM or fax us at BE3-556-0405. You need to provide the Machine |dentification displayed belaw.
If wou are Emailing or faxing be sure and provide complete contact information

Machine Identification [58554B3C

Code Version Date Qct 1, 2010

Date Range

Machines

Serial Number

Release Code

[ =4 Update Release Code ] l ? Help ] [ l-'Lgose ]

Before using thiz software pleasze ieview our online documentation. Some hardware zetup may be required prior to using this A
zoftware.

Thank oul
Online Resources:

hittp: /A technologydretailers. comdt-popollappendices. aspR
hittp: /A techinalogydretalers. comdt-popollbrochures. asps b

Release Code This screen is used to enter the Release Code for the software in the red
box. Once the Release Code is entered and the Update Release Code button is clicked, the software will
become active and the Date Range, Machines, and Serial Number fields will fill in once.

Help The Help menu item opens the Help Files.

Live Capture Window
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The user can have multiple machines collecting data at the same time. They can switch the current view
by clicking on a tab at the top of the screen (in the red box).
With the buttons at the bottom of the screen, the user can do the following:

Pause The Pause button will to pause the operation. Click the button a second time
to restart it.

Send to Email This button will send an email with the data to an email address.

Send to FTP Uploading the data to a FTP site can be done with this button at anytime

from this window.



Individual ECR Setup Instructions

Casio 6x00
PC/Capture can be used as a receipt printer, a report printer, and/or an order printer.

Direct or Modem:

1. -Connect the printer cable to a port.

2. Under I/O Parameters, set item 4 to ‘X103’, where X is the port number the printer cable is
connected to. (Port 4 is recommended if available)

TCP/IP;
1. Goto TCP/IP in the register and setup a printer. (Parameter 11 is TCP/IP printer 1.)
2. The rightmost number is the IP Address.

Setup the printer connection table as you choose.

Casio 7000/8500:
PC/Capture can be used as a report printer, and/or an order printer. It cannot be used it as a receipt
printer. (This is a register limitation)

1. Connect Printer Cable to Port 4.

2. Under I/O Parameters, set item 4 to ‘4103’

Setup the printer connection table as you choose.

CRS 3000

PC/Capture can be used for all printer types on the CRS 3000.
1. Connect to port 2.
2. Use Printer type 3.

Sharp 8x0
PC/Capture can be used as an External journal printer, a Bill printer, or a report printer. It cannot be used
it as a receipt printer. (This is a register limitation)

1. More than one of the listed functions cannot assign to the same printer.

2. Select TM-T88(3)/T-88(4) as the printer type.

Sharp 3500

PC/Capture can be used as any type of printer on the sharp 3500. (Receipt, journal, Report, Bill, KP)
1. Make sure to select “TM-T85/T88(3)/T88 mark4” as the printer type.
2. Turn on Auto Cutter in order to see dividers.

Sharp 600/700

PC/Capture can be used as a Report and/or Bill printer on the sharp 600/700
1. Make sure to select “TM-T88/T85” as the printer type.
2. Turn on Auto Cutter in order to see dividers.

Sharp 330x

PC/Capture can be used as any type of printer on the sharp 3300/3301. (Receipt, journal, Report, Bill)
1. Make sure to select “EPSON TM-T85” as the printer type.
2. Turn on Auto Cutter in order to see dividers.

Sharp 750/770
PC/Capture can be used as any type of printer on the sharp 750/770. (Receipt, journal, Report, Bill)
1. -Make sure to select “EPSON TM-T85” as the printer type.



2.

Turn on Auto Cutter in order to see dividers.

Sam4s 5x0/2000/1000

Direct Connect/Modem:

1.
2.
3.
4,

Select EPSON T88-2 as the printer type.

Select 9600 Baud.

Turn on “Cutting after printing” in order to see dividers.
“Batch” type printer operation is recommended.

TCP/IP: (5x0/2000 ONLY)

1. Select 115200 Baud

2. Turn on “Cutting after printing” in order to see dividers.
Sam4s 70x0

1. Select EPSON T90 as the printer type.

2. Turn on “Cutting after printing” in order to see dividers,

3. “Batch” type printer operation is recommended.

Sam4s 65x0/65x0 I

oukrwnpE

Go to PGM->60

X is 5 for port 1 and 6 for port 2, 7 for port 3, 8 for port 4

X0 =2 (9600 Baud)

X3 =8 (Port is Journal Echo) OR X3 = 2 (Remote Report Printer)

X5 =3 (TM-T85)

This register does not seem to support auto cutters, so there will be no dividers.

Sam4s 52xx/52xxM/28x

Nogkwbr

Go to S Mode.

Pgm 80 for port 1, 81 for port 2

Xis 5 for port 1 and 6 for port 2, 7 for port 3, 8 for port 4

1 =0 (9600 Baud)

5 = 3 (Port is Remote Journal) OR 5 = 4 (Remote Printer)

11 =8 (TM-T88-2)

This register does not seem to support auto cutters, so there will be no dividers.

Sam4s 6xx

1.
2.

AlMsi

Select RJ or RP for port function.
Select the “EPSON TM-T88-2" as the printer type.

Use the settings for an EPSON serial printer.



